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Enterprise Templates
<Instructor Notes: A significant portion of this lab consists of file manipulation outside the VS.NET environment.  Depending on a student’s savvy with the Windows OS and their familiarity with the VS.NET, completing this lab may take anywhere from 55 to 90 minutes.  For this reason, the 4th Task of Exercise 1 has been marked optional. If students have exceeded 30 minutes by this point – and it is likely that a majority of them will – have them move directly to exercise 2 (the lab itself recommends this).

The lab has been peppered with considerably commentary that describes the purpose of certain operations, the theory behind Enterprise Templates, and so forth.  Due to the length of the lab it is recommended that as much time as possible be allotted for lab work.  It other words, get students working on the lab ASAP>

Requirements

In order to complete this walkthrough you will need a fresh installation of Visual Studio .NET 2003.  Microsoft Word is also recommended so that you can view this document electronically while carrying out the lab (the lab suggests pasting code directly from this document into VS.NET)
Lab Objective    

Estimated time to complete this lab: 60 minutes

The purpose this lab is to illustrate the benefits of Enterprise Templates to developers. Enterprise Templates allow architects and managers to promote and enforce project structures and design patterns in Visual Studio .NET.  Simply put, an Enterprise Template prescribes the project structure a user receives when he or she creates a project with that template.  The contents of an Enterprise template are twofold:

1. An initial application structure, which prescribes the boilerplate files users receive when they create a project based on the template.
2. A policy file, which allows one to customize, control and restrict the VS.NET environment when a certain project is created.
The initial application structure of a project can be created using one of the three techniques listed in Table 1.1.
	Technique
	Approach
	Comments

	Static Prototypes
	Create a project structure in VS.NET and convert it to a template via a few manual steps
	Most limited because template is static (i.e., cannot generated namespaces, filenames, etc., based on project parameters)

	Subproject wizards
	Modify/leverage already existing VS.NET wizards to execute programmatic code when a project is created
	Requires writing custom JScript code for the wizard and some manual boilerplate work, but allows dynamic content

	Custom Wizard
	Create a custom wizard in native C++ that executes when the project is created
	Maximum flexibility as you are writing versatile C++ code; also the most complex approach.


Table 1.1 – Techniques to create a project structure
In this lab you will create Enterprise templates using the first and second techniques.  This lab is based on the DEV334 session.
	Pre-lab tasks: Setting up the environment

Working with Enterprise Templates involves a considerable amount of file manipulation.  These pre-lab steps will configure the Windows environment such that file manipulation is made easier. 
Exercise 1: Static Templates and Policy

In this exercise you will develop an Enterprise Template that creates an initial project structure using static prototypes. The initial project structure will be modeled after a three-tier application design. The final part of this lab will utilize the policy file to enforce certain restrictions within the VS.NET environment.

Exercise 2: Wizards and the VS.NET IDE

In this part of the lab you will give the template some dynamic content. In specific, a wizard will be added to the template that generates a private key on-the-fly and associates it with the ClassLibrary project in the Database-tier of the application. The final part of this lab, unrelated to the first portion, will illustrate how to customize the New Project Dialog Box in VS.NET by means of registry settings.


Pre-lab Tasks – Setting up the environment

The tasks in this section are designed to help carry out the core Lab tasks that follow.  As you will see, working with Enterprise Templates involves a considerable amount of file manipulation outside the Visual Studio .NET environment.  The following tasks will make it more convenient to work with files using the Windows Explorer and manipulate the files you will create. 
Task 1 – Display hidden files, folders, and file extensions in Windows Explorer
An important part of this lab is identifying the various file types (.etp, .vsdir, .csproj) that constitute an Enterprise Template.  The default settings in Windows Explorer can make it difficult to identify the proper files if file extensions are not visible or if hidden folders and files are not shown.  
To display hidden, files, folders, and file extensions:  

· Lunch the Windows Explorer, go to the Windows Explorer Tools menu and click Folder Options, and then click the View Tab.
· Find Hidden files and folders, and select Show hidden files and folders. 
· Find Hide file extensions for known file types and clear the check box.
· Click OK
· Close the Windows Explorer.
Task 2 – Create a working directory for your projects 

By default, Visual Studio .NET places new projects in a deeply nested directory such as:

C:\Documents and Settings\SomeUser\My Documents\Visual Studio Projects\

Since Enterprise Templates files must be manually copied and manipulated, it is helpful to place your projects in a more convenient directory.  To this end, create a new root directory on the computer named MyProjectFiles.

Note: Although you can give your directory a different name than MyProjectFiles, it is highly recommended that you use this name as subsequent lab exercises will assume this location for projects. 
To create a new root directory on the computer:
· Launch the Windows Explorer, and navigate to the drive on the system where the Operating System is installed (usually the C:\ drive)
· Go to the File menu and click New
· Rename the newly created folder MyProjectFiles (the folder will automatically be highlighted after the previous step)
Exercise 1 – Static Templates and Policy
<Instructor Notes: This portion of the lab will likely consume the most time, as it involves some arduous file manipulation.  The creation of both the base Form and the Enterprise Template project is straightforward.  The conversion of the ET project into a VS.NET template, however, involves some delicate file conversion and modification, and it is in this area where students will likely encounter the most problems.  The following lists some common problems students will encounter:

The initial Enterprise Template project does not build in Visual Studio .NET – the student likely copied the Main() method in Table 1.2 incorrectly.  The Main() method must be placed within the declaration of the FirstForm class.  In addition, if the student has given the Form a name other than FirstForm, the Run() method in Table 1.2 should read: Application.Run(new FormName());

Visual Studio .NET reports policy file errors when a project based on the ET template is created -- the student has likely incorrectly pasted the code from Tables 1.5 and 1.6 into the policy file.  This code should be placed at the top of the policy file after the sample element that has been commented out.
The custom template does not appear in VS.NET’s New Project Dialog Box – this is likely a result of an ill formatted .vsdir file.  The sample text (just before Table 1.4) must be verbatim into the .vsdir file, and it must also be the first and only line in the file.
>
In this exercise you will develop an Enterprise Template that creates an initial project structure using static prototypes.  When users create a project based on this template they will get a project that consists of:

1. A Database-tier that houses database logic code
2. A Business-tier that houses business logic code
3. A Presentation-tier that houses the GUI interface

This architecture will take the form of a .NET Solution with three sub-solutions, each of which contains a C# language project.  Thus, when users create a project using this template, the Solution Explorer in Visual Studio .NET will look similar to Figure 1.1

[image: image1.png]1o Solution 'MyTemplateProject1' (1 project)
= B3 myTempatebroectt
= &3 ooLayer
= myclasslbrary
= References
] assemblyinto.cs
[ sst.cs
= &3 ndeLayer
= & nddeLayerpror
w (ol Refersnces
] Assemblyinto.cs
] clsst.co

= @
UlLayerrog
w2l Refersnces
e
] assenbiyinto.cs
FistForm.cs





Figure 1.1 – The Structure of the Enterprise Template

As illustrated in Figure 1.1, the UI layer of the template contains of a Windows Form. Two other requirements for the Enterprise Template are as follows: 

1. The template’s Windows Form will visually inherit from a base Form that you will create.
2. The Enterprise Template will restrict what items may be added to various aspects of the project.  For example, developers will not have the capability to add additional projects to the main Solution (MyTemplateProject1 in Figure 1.1).  These rules will be enforced by means of the template’s policy file.  
Task 1 – Create a Base Form
In this section you will create the base Form from which the Windows Form in the template will inherit.  That is, when users create a project based on this template the initial Windows Form will inherit from the base Form you create in this step. By having the GUI portion of the template inherit from a base Form you can implicitly stipulate that Forms within the template adhere to certain guidelines (e.g., color, width, etc) and are prepackaged with important functionality (e.g., authentication code that executes before the Form displays).  
Although the base Form in this lab will be simple for the purposes of demonstration, a real world example would house common code and characteristics relevant to your organization or project 

To create a base Form: 
· Open Visual Studio .NET 2003.

· On the File menu, point to New, and then click Project. The New Project dialog box appears.

· In the Project Types pane, select Visual C# Projects. Select ClassLibary in the Templates pane, change the project name to "MyBaseForm", change the project location to the folder you created in the previous exercise (C:\MyProjectFiles), and click OK (see Figure 1.2).
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Figure 1.2 – The New Project Dialog Box

· Go to the Project menu and click Add Windows Form
· The Add New Item dialog box appears.

· Change the Form name from Form1.cs to “MyBaseForm”, and click Open
· Visual Studio .NET will give the project an empty Form and display it on the screen.  
· Using the environment’s toolbox, drag a label onto the Form. 
Note: if the toolbox is not visible within the IDE you can display it by going to the View menu and clicking Toolbox. 
· Using the VS.NET Property Inspector change the Label’s Text caption to “My Base Form”.  In addition, change the Label’s Font Size to twenty by expanding the Font property in the Property Inspector and changing the Size property to 20. 

· Resize the Form within the VS.NET environment such that it resembles the one depicted in Figure 1.3.  The Form can be resized by modifying the Form’s Height and Width properties using the Property Inspector or by directly resizing the Form in the environment using the mouse. 
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Figure 1.3 – the base Form for the template

· Using the Configuration Manager shown in Figure 1.4 set the project to build in Release Mode.  In general, components added to an Enterprise Template (such as this base Form) should be built in Release mode before the template is created.  
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Figure 1.4 – Setting the project to Release Mode

· Build the project by going to the Build Menu and clicking Build Solution.  This step creates a DLL file that houses the base Form you just created, and will be leveraged in the next Task when you create the initial application structure. 
Task 2 – Create the initial template structure
In this section of the Lab you will create an Enterprise Template using the static prototype technique. Recall that one aspect of an Enterprise Template is the initial project structure, which defines the boilerplate files a user receives when they create a new project based on the template.  

Under the static model a template’s initial structure is created by means of the Enterprise Template Project option in VS.NET. When you create a project of this type in VS.NET, the files you add to the project define the initial structure of the template.  For example, if you want users to automatically get a helloworld.cs file when they create an instance of your template, you would add a helloworld.cs file to the Enterprise Template project.  Similarly, if you want the initial application structure to automatically reference the System.XML.dll assembly, simply add a reference to it (you might also reference custom DLLs that you or your company have developed). 

Once the initial project structure has been configured to your liking it must be exposed to VS.NET as a valid template by means of some intricate file manipulation; the next Task will illustrate this approach. 

To create the initial application structure for this template:

· Open Visual Studio .NET 2003 (if it is not already opened)
· On the File menu, point to New, and click Project. 
· The New Project Dialog Box appears.

· In the Project Types pane, expand the Other Projects folder and select the Enterprise Template Projects folder. The Templates pane displays a number of icons. Select Enterprise Template Project (do not double-click the icon so that you can assign a custom name and location before creating the project). 

· Replace the default project name with MyTemplate, change the project location to C:\MyProjectFiles, and click OK (see Figure 1.5)
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Figure 1.5 – Creating the Enterprise Template project

As illustrated in Figure 1.2 this Enterprise Template solution will in turn consist of three sub-solutions.  To give the newly created template the appropriate sub-solutions:
· Select MyTemplate in Solution Explorer (not the root node Solution 'MyTemplate'),
· On the File menu, point to Add Project, then click New Project
· The Add New Project dialog box appears. 

· Select Enterprise Template Projects in the Project Types pane, and then select Enterprise Template Project in the Templates pane.
· Change the project name to “DBLayer”, and then click OK.

· The DBLayer solution appears in Solution Explorer. 

· Repeat this process twice, changing the name to “MiddleLayer” the first time and to “UILayer” the second time.
Note: be sure to select the MyTemplate solution node in the Solution Explorer (not the root node Solution 'MyTemplate') before adding each project.

As it stands, the initial application structure consists of four empty solutions. To make the template more useful, each sub-solution should be given a language project with some content.  This example will use C# language projects, but, in practice, you may use any type of project for other templates.   

To give each sub-solution a language project:

· In Solution Explorer select the DBLayer solution node.
· On the File menu, point to Add Project, and then click New Project. 
· The Add New Project dialog box appears. 

· Select Visual C# Projects in the Project Types pane. 

· In the Templates pane, select Class Library. Change the name to DBLayerProj and click OK. 

· The DBLayerProj project appears in Solution Explorer along with its contents (AssemblyInfo.cs, Class1.cs)
· In Solution Explorer select the MiddleLayer solution node.
· On the File menu, point to Add Project, and then click New Project. 
· The Add New Project dialog box appears. 

· Select Visual C# Projects in the Project Types pane. 

· In the Templates pane, select Class Library. Change the name to MiddleLayerProj and click OK. 

· The MiddleLayerProj project appears in Solution Explorer along with its contents (AssemblyInfo.cs, Class1.cs)

· In Solution Explorer select the UILayer Solution
· On the File menu, point to Add Project, and then click New Project. 
· The Add New Project dialog box appears. 

· Select Visual C# Projects in the Project Types pane. 

· In the Templates pane, select Windows Application. Change the name to UILayerProj and click OK. 

· The UILayerProj project appears in Solution Explorer along with its contents (AssemblyInfo.cs, Form1.cs)

Under the static model, when users create a project based on your template they will get the structure that you have defined here (three sub-solutions with three C# language projects).  At this point, you would configure the initial application structure to reflect the particularities of your template.  For example, you would reference appropriate Base Class Libraries such as System.Security.DLL, add items to the language projects such as custom classes and Forms, and so on.  

For the purposes of this example, you will perform one custom configuration step and give the UI Layer a Form that inherits from the base Form you previously created:
· In the Solution Explorer select Form1.cs, right click it and click Delete.

· A dialog box claiming that Form1.cs will be permanently deleted appears. 

· Click OK to remove Form1.cs from the project. 

· In the Solution Explorer select the UILayerProj project
· Go to the Project menu and click Add Inherited Form
· Give the Form a name of “FirstForm.cs” and click Open.
· The Inheritance Picker Dialog Box appears (Figure 1.6).  Click Browse and select the base Form DLL that you created in Task 1 of this exercise and click Open; you can find this file in the following location:
C:\MyProjectFiles\MyBaseForm\bin\Release\MyBaseForm.dll
· The Inheritance Picker will display all the Forms in the DLL from which you can inherit. Choose the MyBaseForm Form (the only one available), and click OK. 
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Figure 1.6 – The Inheritance Picker

· A Form called FirstForm that visually inherits from MyBaseForm appears in the VS.NET IDE.

Since you deleted the project’s primary Form (Form1.cs), you must make FirstForm the startup Form for the project. Before you can do this you must first add a Main() method to FirstForm that starts the application (only primary Forms are given Main() methods in C#, hence the requirement that you add it manually). 
· Right click the FirstForm Form in the VS.NET environment and select View Code
· The code for the Form appears
· Add the designated code in Table 1.2 to the FirstForm class (the code to add has been enclosed within comments; as illustrated, it should be placed after the declaration of the FirstForm class)

Note: to save some typing you can paste the code directly into the project by copying it from this document and then going to the Edit menu in VS.NET and clicking Paste.
	namespace UILayerProj 
{ 
   public class FirstForm : MyBaseForm.MyBaseForm
   {

      // Code to add starts here ---------------------------------

      [STAThread]

      static void Main() 

      {

         Application.Run(new FirstForm());


}

      // Code to add ends here   ---------------------------------


Table 1.2 – The Main() method for the Form

· Go to the Project menu and click UILayerProj Properties.
· The Property Pages Dialog Box appears. 
· Click the General tab under the Common Properties folder in the left pane. 

· Change the Startup Object in the right pane to UILayerProj.FirstForm as illustrated in Figure 1.7.
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Figure 1.7 – Choosing the Startup Object for the Form

· Click OK
You are almost finished creating the initial project structure.  The last step is to associate the template with a policy file.  Recall that a policy file allows one to customize, control and restrict the VS.NET environment when an instance of the template is created. 

To associate the template with a policy file:

· Select the MyTemplate node in Solution Explorer (not the root node Solution 'MyTemplate'), right-click, and select Properties. 

· In the Properties window, locate the Policy File property in the left column of the grid. Click the ellipsis button (…) on the right column of the grid, which allows you to select the policy file. 
Note: if there is no ellipsis button (…) then simply click the right column of the grid.
· The Select a TDL File Dialog Box appears.
· Within the dialog box, click the DAP.TDL file and press Ctrl+C to copy it. 

· Press Ctrl+V and a copy of the file named Copy of DAP.tdl appears in the Dialog Box. 
· Right-click on the Copy of DAP file, click Rename and rename the file MyPolicy.tdl
· Select MyPolicy.tdl and click Open to associate it with your template
· When prompted to reopen the project, click Yes.

· Select MyTemplate in the Solution Explorer and the Policy File property in the Properties window now displays MyPolicy.tdl (and the directory in which it is located).
You have now created your initial application structure.  To verify that it was created successfully:
· Go to the Build menu and click Build Solution. 
· VS.NET will build all three projects in the template; if there are any errors carefully ensure that you have followed the previous steps.
Note: there is no stipulation that the project be Built in Visual Studio .NET – it is simply performed here to ensure that the initial application structure was successfully created. 
Task 3 – Exposing the template in Visual Studio .NET

As it exists, the project you just created is simply an Enterprise Template project – it has not been exposed to Visual Studio .NET as a template. Exposing Enterprise Template projects to Visual Studio .NET is a manual process that requires some intricate file manipulation.   Before beginning this process, save the entire solution in Visual Studio .NET and then close the environment to prevent file sharing problems.
Visual Studio .NET looks in following directory to determine which Enterprise Templates are exposed to developers:
C:\Program Files\Microsoft Visual Studio .NET 2003\EnterpriseFrameworks
This directory contains three subdirectories -- Policy, Projects and ProxyProjects – which house the files necessary to expose Enterprise Templates to the development environment. Becoming a first class Enterprise Template developer requires intimate knowledge of the structure and contents of these directories. 
Exposing the project you just developed as an Enterprise Template requires converting the project into a form understandable by Visual Studio .NET.  To large extent, the conversion process involves file modification and copying. 
· To begin use the Windows Explorer and copy the entire directory for the solution you created in the previous Task (remember to first close VS.NET):
C:\MyProjectFiles\MyTemplate
to the Enterprise Template Projects directory located at:
C:\Program Files\Microsoft Visual Studio .NET 2003\EnterpriseFrameworks\Projects

Thus, after the copy operation you should have a second copy of the template at:

…\%VSNETRoot%\EnterpriseFrameworks\Projects\MyTemplate

It is this second copy of the template that you will now convert so as to expose the template to VS.NET.  Begin the conversion process by:

· Deleting the *.eto, *.sln, *.suo files from the MyTemplate directory and its subdirectories. These files are extraneous and are not used by VS.NET for template purposes. 
Note: To save time you can omit this step as the template will still work with these files present. You should remove them, however, when deploying Enterprise Templates in practical scenarios.
When VS.NET creates solutions it assigns each Enterprise Template project file (.etp file) a Globally Unique Identifier (GUID).  Remember, that an enterprise template is not really a project itself; rather it is a skeleton template that developers use to create their own projects.  You must therefore remove the GUID that VS.NET assigns to each Enterprise Template project file.  

· Using NOTEPAD, edit each of the following files:  
...\%VSNETRoot%\EnterpriseFrameworks\Projects\MyTemplate\MyTemplate.etp

...\%VSNETRoot%\EnterpriseFrameworks\Projects\MyTemplate\DBLayer\ DBLayer.etp
...\%VSNETRoot%\EnterpriseFrameworks\Projects\MyTemplate\MiddleLayer\MiddleLayer.etp

...\%VSNETRoot%\EnterpriseFrameworks\Projects\MyTemplate\UILayer\UILayer.etp

      and remove the GUID lines which look something like:
     <GUIDPROJECTID>{1DEF4E97-FA5A-4053-9C26-D7F537C8273A}</GUIDPROJECTID>
      MyTemplate.etp has three instances of such a line that must be removed; the other files have  

      one instance.
Note: a convenient way to load a file into NOTEPAD is to Right click the file in the Windows Explorer and click Open With; Windows will then list a number of programs that can be used to open the file – choose NOTEPAD and click OK.

· Close NOTEPAD once you have removed GUID references in the aforementioned files.

In the next section of the Lab you will institute rules for the template using the policy file. In order to do this, each solution and project in the template must be made identifiable to the policy file by means of a unique identifier.  For solutions (.etp files), this identifier is specified by embedding a <GLOBALENTRY> element into the .etp file.  For projects (.csproj files), the identifier is specified by means of a TDLELEMENTTYPE attribute in the .csproj file.  

The following table, which shows the insertions you must make in each file using NOTEPAD should clarify matters (note that the text you must insert has been highlighted; to save some typing and reduce the chance of error you can paste the text from this document directly into NOTEPAD)
The paths of language project files are also as listed here for reference:

...\%VSNETRoot%\EnterpriseFrameworks\Projects\MyTemplate\DBLayer\DBLayerProj\DBLayerProj.csproj

...\%VSNETRoot%\EnterpriseFrameworks\Projects\MyTemplate\MiddleLayer\MiddleLayerProj\MiddleLayerProj.csproj

...\%VSNETRoot%\EnterpriseFrameworks\Projects\MyTemplate\UILayer\UILayerProj\UILayerProj.csproj

	File
	Text to insert

	MyTemplate.etp


	 <GLOBALS>

   <GLOBALENTRY>

      <NAME>TDLFILE</NAME>

      <VALUE>MyPolicy.TDL</VALUE>

   </GLOBALENTRY>

   <GLOBALENTRY>

      <NAME>TDLELEMENTTYPE</NAME>

      <VALUE>etpMyTemplate</VALUE>

   </GLOBALENTRY>

</GLOBALS>

	 DBLayer.etp
	 <GLOBALS>

   <GLOBALENTRY>

      <NAME>TDLFILE</NAME>

      <VALUE>MyPolicy.TDL</VALUE>

   </GLOBALENTRY>

   <GLOBALENTRY>

      <NAME>TDLELEMENTTYPE</NAME>

      <VALUE>etpDBLayer</VALUE>

   </GLOBALENTRY>

</GLOBALS>

	 MiddleLayer.etp
	 <GLOBALS>

   <GLOBALENTRY>

      <NAME>TDLFILE</NAME>

      <VALUE>MyPolicy.TDL</VALUE>

   </GLOBALENTRY>

   <GLOBALENTRY>

      <NAME>TDLELEMENTTYPE</NAME>

      <VALUE>etpMiddleLayer</VALUE>

   </GLOBALENTRY>

</GLOBALS>

	UILayer.etp
	<GLOBALS>

   <GLOBALENTRY>

      <NAME>TDLFILE</NAME>

      <VALUE>MyPolicy.TDL</VALUE>

   </GLOBALENTRY>

   <GLOBALENTRY>

      <NAME>TDLELEMENTTYPE</NAME>

      <VALUE>etpUILayer</VALUE>

   </GLOBALENTRY>

</GLOBALS>

	DBLayerProj.csproj
	<UserProperties TDLFILE = "MyPolicy.TDL" 


 TDLELEMENTTYPE = "projDBLayer"

/>

	MiddleLayerProj.csproj
	<UserProperties TDLFILE = "MyPolicy.TDL" 


 TDLELEMENTTYPE = "projMiddleLayer"

/>

	UILayerProj.csproj
	<UserProperties TDLFILE = "MyPolicy.TDL" 


 TDLELEMENTTYPE = "projUILayer"

/>


Table 1.3 – Adding policy identifiers to the template
· Close any instances of NOTEPAD that may be open as a result of your file edits.

As a result of the additions in Table 1.3, the solutions and projects in the template can be identified in the policy file, which you will manipulate in the next part of the Lab.  For example, the UILayer C# project in the template can now be identified in the policy file as projUILayer, which will allow you to control its characteristics (more on this later). 
The conversion process is almost complete.  The last step is to expose the template such that it appears in the Add New Project and New Project Dialog Boxes in Visual Studio .NET.  This is accomplished by means of a .vsdir file.  At first glance, .vsdir files may seem complex, but they are quite straightforward.  When VS.NET loads, it looks in the following directory for .vsdir files:  

C:\Program Files\Microsoft Visual Studio .NET 2003\EnterpriseFrameworks\ProxyProjects

All the .vsdir files within this directory are inspected and their contents are used to populate the project options that appear in the Add New Project and New Project Dialog Boxes. To expose your template you must therefore create a custom .vsdir file in this directory.  The process is outlined below:

· Navigate to the ..\%VSNETRoot%\EnterpriseFrameworks\ProxyProjects directory, create a copy of ProxyProjects.vsdir and call it MyUserTemplate.vsdir (you can copy the file by means of the Windows Explorer or the Command Prompt)

Note: The actual filename (MyUserTemplate.vsdir) is irrelevant as Visual Studio searches for all the .vsdir files within this directory, but use the suggested name for consistency with later portions of the lab. 
· Using NOTEPAD, delete the contents of MyUserTemplate.vsdir and add the following single line to it (to save some typing you can directly paste the following line from this document directly into NOTEPAD)
..\Projects\MyTemplate\MyTemplate.etp|{AE77B8D0-6BDC-11d2-B354-0000F81F0C06}|MyTemplate|0|My user-created template|{AE77B8D0-6BDC-11d2-B354-0000F81F0C06}|125|0|MyTemplateProject
In large part, the complexity of the .vsdir file is a result of its cryptic nature.  Note that the fields in the .vsdir file are separated by means of the vertical bar character (|). The following table explains the purpose of the important fields in this file (skip this explanation if you are running short of time):

	Field Name
	Value in the previous line
	Purpose



	RelPathName
	..\Projects\MyTemplate\MyTemplate.etp
	The file that creates the template should users create a project of this type. 

	LocalizedName
	MyTemplate
	This is the local name of the template and the name that appears in the Add Item dialog

	SortPriority
	0
	An integer representing the sort order and relative priority of the Template in the Dialog box. For instance, if this value were "1," then the template will appear next to other 1s and ahead of all 2s or lower

	Description
	An example user-created template
	A description of the template that appears in the Add Item dialog box when the item is selected.

	SuggestedBaseName
	MyTemplateProject
	The default name for the Template that displayed in the Name field in the dialog box. If the name is not unique, the environment appends the name with an integer. For example, MyTemplate might be changed to MyTemplate1.  


Table 1.4 – Important fields in .vsdir files

The remaining fields – the GUIDs and number (125) -- are used to determine the icon that represents the template in the Dialog Box.  More information on these fields can be found in the MSDN.
· Close any instances of NOTEPAD and Windows Explorer that may be open.

To test if your template was correctly exposed to VS.NET:

· Open Visual Studio .NET 2003.

· On the File menu, point to New, and then click Project.
· The New Project dialog box appears.
· In the Project Types pane, expand the Other Projects folder and select the Enterprise Template Projects folder. The Templates pane displays a number of icons, including your template MyTemplate (see Figure 1.8).

Note: the second part of the Lab will illustrate how to place the template in a more accessible folder.
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Figure 1.8 – The customized template in the New Project Dialog Box

· Accept the default project name and location, and click OK. If you made any errors during the conversion process, VS.NET will display them at this point.  Note the errors it reports and carefully ensure that you have accurately followed all the steps in this section (typographical errors are a common problem).
· Visual Studio .NET will create an entire three-tier solution for you based on the template you created: three solutions named DBLayer, MiddleLayer and UILayer; three C# projects named: DBLayerProj, MiddleLayerProj, UILayerProj; and finally, a Form in the UILayerProj project named FirstForm that inherits from the base Form you created in the first Task.

Task 4 – Implementing the Policy for the Template
Note: completing this section is NOT required for the second part of the lab.  If you have exceeded 30 minutes by this point consider moving on to the second exercise and return to this Task if you have remaining time thereafter.
Your template up to this point provides developers with a three-tier application structure when they create projects based on the template.  Once the initial project structure is created, however, the user can do anything they wish.  For example, they can add new projects to the various solutions and add new items (ClassLibraries, Windows Forms, etc) to the individual projects.  

As you will see, the usefulness of Enterprise Templates goes beyond simply providing an initial application structure.  In this portion of the Lab you will instruct Visual Studio .NET to enforce certain rules when developers are working with a project created with your template.  These rules are listed below, along with a snapshot of the Solution Explorer for a project created with this template for reference purposes.

1. Developers should not have the ability to add additional solutions or projects to the four solutions of the template (MyTemplate, DBLayer, MiddleLayer, UILayer). 

2. Developers should only be allowed to add class files (.cs files) to the DBLayerProj and MiddleLayerProj projects of the template.

3. Developers should only be allowed to add Windows Forms items to the UILayerProj project of the template.
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Figure 1.9 – Example of the solution tree 

The motivation behind these rules is to enforce and maintain a certain structure within the template. For example, if users could add additional tiers to the top-level solution (MyTemplate), then the three-tier architecture would break.  Similarly, if users could add UI components to the DBLayerProj and MiddleLayerProj projects, then the logical division of the application into tiers would make little sense. 

These rules can be enforced by means of the policy file (MyPolicy.TDL) that you associated with the project in the second Task in this Lab. The following steps describe how to implement the aforementioned rules within the policy file. 
· Open Visual Studio .NET 2003 
· On the File menu, point to Open, and then click File
· The Open File dialog box appears

· Browse to the policy file you associated with the template.  The policy file can be found in the following location:
C:\Program Files\Microsoft Visual Studio .NET 2003\EnterpriseFrameworks\Policy\MyPolicy.TDL
· Click Open to load the file into Visual Studio .NET
If you inspect the contents of the policy file you will see it contains numerous XML elements.  Policy files are written in Template Description Language (TDL), which is an XML-specification that describes the environmental characteristics of VS.NET.  At its root, TDL is based on the concept of an ELEMENT.  An ELEMENT is an entity upon which you can prescribe rules.  Near the top of MyPolicy.tdl is an example element that you can inspect.  

Before the example element is a <POLICYMODE> tag that may have a value of PERMISSIVE.  If it does have such a value, change this value to RESTRICTIVE such that the element now reads:

<POLICYMODE>RESTRICTIVE</POLICYMODE>

You are now in a position to implement the rules previously stated.  To implement the last rule – the provision that only Windows Forms are permissible additions to the UILayerProj project -- embed the text in Table 1.5 after the example element near the top of the policy file.
To save typing, you can copy the text directly from this document into the policy file in Visual Studio .NET.  Note: when pasting text from this document into the policy file use the Paste as HTML option under the Edit menu in Visual Studio .NET.
	<ELEMENT>


<ID>projUILayer</ID>


<IDENTIFIERS>



<IDENTIFIER>




<TYPE>PROJECT</TYPE>




<IDENTIFIERDATA>





<NAME>GLOBAL:TDLELEMENTTYPE</NAME>





<VALUE>projUILayer</VALUE>




</IDENTIFIERDATA>



</IDENTIFIER>


</IDENTIFIERS>


<PROTOTYPES>



<PROTOTYPE>




[EF]\Projects\MyTemplate\UILayer\UILayerProj\UILayerProj.csproj



</PROTOTYPE>


</PROTOTYPES>


<ELEMENTSET>



<DEFAULTACTION>EXCLUDE</DEFAULTACTION>



<ORDER>INCLUDEEXCLUDE</ORDER>



<INCLUDE>codeWinForm</INCLUDE>


</ELEMENTSET>

</ELEMENT>


Table 1.5 – TDL code to implement first rule
The effect of the code you just added to the policy file is straightforward with a little explanation.  A brief explanation is offered here; if you are running short of time move to the next Task – “Implementing the remaining rules in the Policy File” and consult this explanation after the lab.
Tangent – ELEMENTS and the policy file  

Note that the element in Table 1.5 has been given a name of projUILayer by means of the <ID> tag.  Also note that to determine if an entity is a projUILayer element VS.NET consults the contents of the <IDENTIFIERDATA> tag. As shown in Table 1.5, this tag contains two sub-tags: <NAME> and <VALUE> with values of GLOBAL:TDLELEMENTTYPE and projUILayer, respectively.  
In other words, if a file is added to the VS.NET environment and it has a global identifier named TDLELEMENTTYPE with a value of projUILayer , VS.NET will consider it to be a projUILayer element. Refer back to Table 1.3 and you will see that you added these exact parameters to the UILayerProj.csproj file. Thus, UILayerProj projects will be considered projUILayer elements because of the TDL code in Table 1.5.  Why is this identification important? The answer lies in the next important tag: <ELEMENTSET>.

The <ELEMENTSET> tag prescribes which items may be added to the element within the Visual Studio.NET environment.  These items are specified using the <INCLUDE> tag.  As you can see from Table 1.5, the <ELEMENTSET> tag contains only one <INCLUDE> tag that stipulates that only Windows Forms may be added.  You could embed additional <INCLUDE> tags to allow other types of items to be added to this type of element:

        <ELEMENTSET>

            <DEFAULTACTION>EXCLUDE</DEFAULTACTION>

            <ORDER>INCLUDEEXCLUDE</ORDER>

            <INCLUDE>codeWinForm</INCLUDE>
            <INCLUDE>Another element here</INCLUDE>

        </ELEMENTSET>

Browse the policy file and you will find many elements for existing .NET items: codeClass, codeUserControl, codeCustomControl, codeInstallerClass, codeWebForm, codeWebControl.  For example, the codeWinForm item is used to represent a Windows Forms. Look at the definition for the projUILayer element given above, and you will see that because of the <ELEMENTSET> definition, only Windows Form items may be added to the project.  

For a more detailed explanation of elements and policy file syntax consult the MSDN. 
Task 5 – Implementing the remaining rules in the Policy File

The following table contains the TDL code required to implement the remaining rules in the policy file.  Paste this code directly under the element you just added (remember to use the Paste as HTML option in VS.NET)
	<ELEMENT>

<ID>projDBLayer</ID>

<IDENTIFIERS>

    <IDENTIFIER>

        <TYPE>PROJECT</TYPE>

        <IDENTIFIERDATA>

            <NAME>GLOBAL:TDLELEMENTTYPE</NAME>

            <VALUE>projDBLayer</VALUE>

        </IDENTIFIERDATA>

    </IDENTIFIER>

</IDENTIFIERS>

<PROTOTYPES>

    <PROTOTYPE>

        [EF]\Projects\MyTemplate\DBLayer\DBLayerProj\DBLayerProj.csproj

    </PROTOTYPE>

</PROTOTYPES>

<ELEMENTSET>

    <DEFAULTACTION>EXCLUDE</DEFAULTACTION>

    <ORDER>INCLUDEEXCLUDE</ORDER>

    <INCLUDE>codeClass</INCLUDE>

</ELEMENTSET>

</ELEMENT>


	<ELEMENT>

    <ID>projMiddleLayer</ID>

    <IDENTIFIERS>

        <IDENTIFIER>

            <TYPE>PROJECT</TYPE>

            <IDENTIFIERDATA>

                <NAME>GLOBAL:TDLELEMENTTYPE</NAME>

                <VALUE>projMiddleLayer</VALUE>

            </IDENTIFIERDATA>

        </IDENTIFIER>

    </IDENTIFIERS>

    <PROTOTYPES>

        <PROTOTYPE>

            [EF]\Projects\MyTemplate\MiddleLayer\MiddleLayerProj\MiddleLayerProj.csproj

        </PROTOTYPE>

    </PROTOTYPES>

    <ELEMENTSET>

        <DEFAULTACTION>EXCLUDE</DEFAULTACTION>

        <ORDER>INCLUDEEXCLUDE</ORDER>

        <INCLUDE>codeClass</INCLUDE>

    </ELEMENTSET>

</ELEMENT>


	<ELEMENT>

    <ID>etpMyTemplate</ID>

    <IDENTIFIERS>

        <IDENTIFIER>

            <TYPE>PROJECT</TYPE>

            <IDENTIFIERDATA>

                    <NAME>GLOBAL:TDLELEMENTTYPE</NAME>

                <VALUE>etpMyTemplate</VALUE>

            </IDENTIFIERDATA>

        </IDENTIFIER>

    </IDENTIFIERS>

    <ELEMENTSET>

        <DEFAULTACTION>EXCLUDE</DEFAULTACTION>

        <ORDER>INCLUDEEXCLUDE</ORDER>

    </ELEMENTSET>

    <PROTOTYPES>

        <PROTOTYPE>

            [EF]\Projects\MyTemplate\MyTemplate.etp

        </PROTOTYPE>

    </PROTOTYPES>

</ELEMENT> 



	<ELEMENT>

    <ID>etpDBLayer</ID>

    <IDENTIFIERS>

        <IDENTIFIER>

            <TYPE>PROJECT</TYPE>

            <IDENTIFIERDATA>

                    <NAME>GLOBAL:TDLELEMENTTYPE</NAME>

                <VALUE>etpDBLayer</VALUE>

            </IDENTIFIERDATA>

        </IDENTIFIER>

    </IDENTIFIERS>

    <ELEMENTSET>

        <DEFAULTACTION>EXCLUDE</DEFAULTACTION>

        <ORDER>INCLUDEEXCLUDE</ORDER>        

    </ELEMENTSET>

    <PROTOTYPES>

        <PROTOTYPE>

            [EF]\Projects\MyTemplate\DBLayer\DBLayer.etp

        </PROTOTYPE>

    </PROTOTYPES>

</ELEMENT>


	<ELEMENT>

    <ID>etpMiddleLayer</ID>

    <IDENTIFIERS>

        <IDENTIFIER>

            <TYPE>PROJECT</TYPE>

            <IDENTIFIERDATA>

                    <NAME>GLOBAL:TDLELEMENTTYPE</NAME>

                <VALUE>etpMiddleLayer</VALUE>

            </IDENTIFIERDATA>

        </IDENTIFIER>

    </IDENTIFIERS>

    <ELEMENTSET>

        <DEFAULTACTION>EXCLUDE</DEFAULTACTION>

        <ORDER>INCLUDEEXCLUDE</ORDER>

    </ELEMENTSET>

    <PROTOTYPES>

        <PROTOTYPE>

            [EF]\Projects\MyTemplate\MiddleLayer\MiddleLayer.etp

        </PROTOTYPE>

    </PROTOTYPES>

</ELEMENT>


	<ELEMENT>

    <ID>etpUILayer</ID>

    <IDENTIFIERS>

        <IDENTIFIER>

            <TYPE>PROJECT</TYPE>

            <IDENTIFIERDATA>

                    <NAME>GLOBAL:TDLELEMENTTYPE</NAME>

                <VALUE>etpUILayer</VALUE>

            </IDENTIFIERDATA>

        </IDENTIFIER>

    </IDENTIFIERS>

    <ELEMENTSET>

        <DEFAULTACTION>EXCLUDE</DEFAULTACTION>

        <ORDER>INCLUDEEXCLUDE</ORDER>

    </ELEMENTSET>

    <PROTOTYPES>

        <PROTOTYPE>

            [EF]\Projects\MyTemplate\UILayer\UILayer.etp

        </PROTOTYPE>

    </PROTOTYPES>

</ELEMENT>


Table 1.6 – TDL code the implement the remaining rules

If time permits, examine the code in Table 1.6 and consider what it is doing.  Note, for example, that the solution elements (etpMyTemplate, etpDBLayer, etpMiddleLayer, etpUILayer) do not contain any <INCLUDE> tags within their <ELEMENTSET> tags.  This exclusion stipulates that NO items may be added to these solutions, which was one of stipulated rules.
· Save your additions to the MyPolicy.TDL file by going to the File menu and clicking Save MyPolicy.TDL.

Finally, test the policy file by creating a new project based on the template:

· On the File menu, point to New, and then click Project.
· The New Project dialog box appears.
· In the Project Types pane, expand the Other Projects folder and select the Enterprise Template Projects folder. The Templates pane displays a number of icons, including your template MyTemplate (see Figure 1.8).

· Accept the default project name and location, and click OK. If you made any errors while manipulating the policy file, VS.NET will display them at this point.   

· VS.NET will create an entire three-tier solution for you based on the template’s architecture.  

· Click the UILayerProj node in the Solution Explorer.

· Go to the Project Menu and click Add New Item; because of the policy applied to UILayerProj only Windows Forms are permissible additions to the project (Figure 1.10).
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Figure 1.10 – Only Windows Forms available
Note – When VS.NET creates the project it elicits a number of warnings similar to those below.  These warnings appear because the initial application structure breaks the rules implemented in the policy file.  For example, one of the rules stipulated was that only Windows Form items could be added to the UILayer project. Look at Figure 1.9, however, and you will see that the UILayer project contains a ClassLibrary file named AssemblyInfo.cs in the initial application structure. Since this inclusion contradicts the TDL code in Table 1.5, VS.NET produces a warning when the project is created.  Because the rules are designed to be implemented after the initial project structure has been created, these warning can be safely ignored.
Policy Reminder: Project 'MiddleLayerProj.csproj' (Element projCSharpProject, projMiddleLayer) does not allow File 'AssemblyInfo.cs' (Element projItemCSharpFile)

Policy Reminder: Project 'MiddleLayer.etp' (Element etpMiddleLayer) does not allow Project 'MiddleLayerProj.csproj' (Element projCSharpProject, projMiddleLayer)

Policy Reminder: Project 'MyTemplateProject1.etp' (Element etpMyTemplate) does not allow Project 'MiddleLayer.etp' (Element etpMiddleLayer)

Policy Reminder: Project 'UILayerProj.csproj' (Element projCSharpProject, projUILayer) does not allow File 'App.ico' (Element projItemIconFile)

Policy Reminder: Project 'DBLayerWizard.csproj' (Element projCSharpProject, projDBLayer) does not allow File 'AssemblyInfo.cs' (Element projItemCSharpFile) 

Policy Reminder: Project 'DBLayer.etp' (Element etpDBLayer) does not allow Project 'DBLayerWizard.csproj' (Element projCSharpProject, projDBLayer)

Exercise 2– Wizards and the VS.NET IDE

<Instructor Notes: This portion of the lab should take most students between 25 to 35 minutes. As with the first part of the lab, the majority of problems students will encounter here will be typographical errors.  Some common errors include:
Visual Studio.NET reports that the DBLayerProj project is unavailable when an instance of the template is created –The student has likely modified the .etp file incorrectly.  Make sure they follow the specifications in Table 2.3.  Another possible problem is that the JScript code in Table 2.4 was not copied properly into the default1.js file.  Make sure the user removed the original OnFinish() method.

VS.NET reports that there is no <Include> section in DBLayerProj – The user has removed the <Include> tag in the .csproj file.  As highlighted in Table 2.2, this tag should NOT be removed.

The custom template folder and project icon do not display in New Project Dialog Box (Figure 2.4) – the student has likely implemented the registry settings in Figure 2.3 incorrectly.  The settings – particularly the path setting for the TemplatesDir key – must be copied verbatim into the registry.  Even the presence of an extraneous character will confuse VS.NET.

>
The first part of the lab illustrated two powerful aspects of Enterprise Templates – the ability to give developers a predefined application structure; and the ability to enforce certain rules within the VS.NET environment in order to promote design patterns. 
One limitation with the template created in the first part of the lab, however, is that it is static.  If a developer creates ten project instances based on the template, the content for all ten projects will be identical (with the exception of the utmost solution name, which would be MyTemplate1, MyTemplate2, etc).  That is, every project will have three solutions named DBLayer, MiddleLayer and UILayer, and three C# projects named DBLayerProj, MiddleLayerProj and UILayerProj.

A more versatile option when creating Enterprise Templates is to use wizards instead of static project prototypes. To understand the difference between the two, use NOTEPAD to open the following Enterprise Template file you created in the first part of the Lab:  

…%VSNetRoot%\EnterpriseFrameworks\Projects\MyTemplate\DBLayer\DBLayer.etp

Within this file you will find the following lines:

      <References>

            <Reference>

                <FILE>DBLayerProj\DBLayerProj.csproj</FILE>

            </Reference>

       </References>

These lines instruct Visual Studio .NET to create a project under the DBLayer solution according to the specifications in the DBLayerProj.csproj file. The latter file, which you also created in the first part of the lab, is a static C# sharp project that contains two files named AssemblyInfo.cs and Class1.cs. This is why every template instance gets the same files – because the three solutions within the template (DBLayer, MiddleLayer and UILayer) all point to static C# projects (DBLayerProj, MiddleLayerProj, UILayerProj). 

To overcome this limitation you can point solutions to wizards, which are packets of executable code that can generate files on-the-fly and perform other custom actions.  In this part of the lab you will give your template some dynamic content.  In specific, you will design a wizard that dynamically generates a private key and associates it with the ClassLibrary project in the Database-tier. For information on the role of private keys with respect to assemblies (i.e., shared assemblies), consult the MSDN.

Your wizard will be responsible for two dynamic operations:

Generating the private key by means of the SN.EXE utility:

SN.EXE –k DBLayer.snk

Associating the private key with the AssemblyInfo.cs file in the Database-tier:

[assembly: AssemblyKeyFile("..\\..\\..\\DBLayer.snk")]
As you will see, because you can leverage the preexisting wizards that are packaged with VS.NET, adding dynamic content to a template is mostly a matter of file manipulation.  
Task 1 – Creating the wizard files 
· Close any open instances of NOTEPAD or The Windows Explorer.

· If it is open, close Visual Studio .NET to prevent file sharing problems.

The preexisting wizards that Visual Studio .NET uses to build common .NET projects (Windows Forms applications, ClassLibraries, etc) can be found in the following directory:  
C:\Program Files\Microsoft Visual Studio .NET 2003\EnterpriseFrameworks\EFWizards
· Building your own Enterprise Template Wizards is most easily done by leveraging and modifying a preexisting wizard.  To that end, navigate to the aforementioned directory using the Windows Explorer
· Within the Windows Explorer, select the csharpdllwiz folder and press Ctrl+C to copy it. 

· Press Ctrl-V and a copy of the folder named Copy of csharpdllwiz will appear in the Explorer 
· Right-click on the Copy of csharpdllwiz folder, click Rename, and rename the folder MyWizard
· You now have a copy of a preexisting wizard that you can customize for your template.  Figure 2.1 depicts the folder structure for the wizard.
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Figure 2.1 – Wizard folder structure

· The Scripts\1033 folder houses a file named default1.js that contains custom JScript for the wizard (1033 is the language code for English; it will differ for other language versions of VS.NET). You will modify this script momentarily to implement the desired functionality. 
· The Templates\1033 folder contains the items that are added to the project by the wizard. Examine the file1.cs file within this folder using NOTEPAD, and you will see such statements as [!output SAFE_NAMESPACE_NAME] and [!output SAFE_CLASS_NAME]. As you will see, these are replaceable parameters that will be populated by the wizard during the creation of the project.  
Before you can connect this wizard to your template, you must create initial .csproj and .vsz files.  The former is an empty project file that the wizard operates on; the latter points VS.NET to the wizard files you just copied (don’t worry if these intricate file details escape you at this moment; all will become clear when you are done).  The .csproj and .vsz wizard files can be found in the following directory:

…\EnterpriseFrameworks\Projects\CSharp Building Blocks
· Since your wizard will work against the Database layer of the template, copy the DBLayerProj.csproj file from the following directory you created in the first part of the lab:

..\%VSNETRoot%\EntepriseFrameworks\Projects\MyTemplate\DBLayer\DBLayerLayerProj
to the directory just mentioned:
…\EnterpriseFrameworks\Projects\CSharp Building Blocks
Now you have to create the .vsz file.  Thankfully, you can leverage an already existing file:

· If you haven’t already done so, navigate to the …\EnterpriseFrameworks\Projects\CSharp Building Blocks directory using the Windows Explorer
· Within the Windows Explorer, select the BusinessFacade.vsz file and press Ctrl+C to copy it. 

· Press Ctrl-V and a copy of the file named Copy of BusinessFacade.vsz will appear in the Explorer 
· Right-click on the Copy of BusinessFacade.vsz file, click Rename and rename the file DBLayerWizard.vsz
· Open the DBLayerWizard.vsz file using NOTEPAD and modify its contents to reflect those given in Table 2.1 (the required changes have been highlighted)
	VSWIZARD 7.0

Wizard=VSWizard.VsWizardEngine.7.1

Param="WIZARD_UI = FALSE"

Param="WIZARD_NAME = MyWizard"

Param="PROJECT_TYPE = ETPROJ"

Param="SCRIPT_COMMON_PROJECT_TYPE = CSPROJ"

Param="EFT_PROTOTYPE = DBLayerProj.csproj"




Table 2.1 – Changes to the .vsz file
As you can see, the .vsz file is really a “pointer” file that specifies: 1.) the real wizard - MyWizard; 2.) The project prototype the wizard operates on - DBLayerProj.csproj.
· Next, open the DBLayerProj.csproj using NOTEPAD and remove the following highlighted lines from it:
	<Files>

   <Include>

      <File

         RelPath = "AssemblyInfo.cs"

         SubType = "Code"

         BuildAction = "Compile"

      />

      <File

         RelPath = "Class1.cs"

         SubType = "Code"

         BuildAction = "Compile"

      />

   </Include>

</Files>



Table 2.2 – Changes to the .csproj file

The highlighted lines in Table 2.2 specify those files that are packaged with the project.  Since these files will be built on-the-fly by the wizard, they must be removed from the project specification (note that you must NOT remove the <Files> and <Include> nodes). By removing the aforementioned lines from the project file, you have converted in into an “empty project” that the wizard will operate on. 
Task 2 – Connecting the wizard to the template
· You must now connect the wizard to the Database-tier of your template.  Using NOTEPAD, open the DBLayer.etp file which can be found in the following directory:
..\%VSNETRoot%\EnterpriseFrameworks\Projects\MyTemplate\DBLayer\DBLayer.etp
· Remove the <ProjectExplorer> and <Reference> nodes from the file along with their contents, and add the highlighted text in Table 2.3 to it as well.
Note: the <ProjectExplorer> and <Reference> nodes are located within the <Views> and <References> nodes, respectively.
	<GENERAL>

   <BANNER>Microsoft Visual Studio Application Template File</BANNER>

   <VERSION>1.00</VERSION>

   <SUBPROJECTWIZARDS>

      <WIZARD>

         <FILE>..\..\..\Projects\CSharp Building Blocks\DBLayerWizard.vsz</FILE>

      </WIZARD>

   </SUBPROJECTWIZARDS>
   <Views>

   </Views>

   <References>

   </References>

</GENERAL>




Table 2.3 – Changes to the .etp file

As a result of these modifications, the template will create the Database-tier by means of the DBLayerWizard.vsz file.  Remember from Table 2.1 that this file is simply a pointer to the real wizard, whose directory structure is depicted in Figure 2.1. 
Task 3 – Writing the wizard code
To implement the desired functionality of the wizard -- the generation of the private key and association of the key with the AssemblyInfo.cs file -- there are two files that must be modified:
1. …\EnterpriseFrameworks\EFWizards\MyWizard\scripts\1033\default.js
2. …\EnterpriseFrameworks\EFWizards\MyWizard\templates\1033\assemblyinfo.cs
· The first file houses the script for the wizard; the second file is used as a template to the build the project’s AssemblyInfo.cs file.  Open up the latter file in NOTEPAD and replace the following line:

[assembly: AssemblyKeyFile("")]

with:
[assembly: AssemblyKeyFile([!output KEYPATH_FOR_ASSEMBLY])]
This change prescribes that the contents of the AssemblyKeyFile attribute are contained in a wizard variable named KEYPATH_FOR_ASSEMBLY. When the wizard runs it will replace the [!output] marker with the real value, such that when the project is created at run-time the line will really read:
[assembly: AssemblyKeyFile("..\\..\\..\\DBLayer.snk")]
· The last remaining step is to add the appropriate JScript code to the aforementioned default.js file.  Open up this file in NOTEPAD and you will see a function named OnFinish().  This function is called right before the wizard finishes executing, and is an appropriate place for custom code.

The JScript code to generate a private key and associate it with the AssemblyInfo.cs file is given in Table 2.4.  The code has been heavily commented; you can scrutinize it after you have finished the lab.  For now, save time by copying the entire OnFinish() function below into the default.js file (remove the existing OnFinish() function first and do not modify the other methods in this file). 
	function OnFinish(selProj, selObj)

{
  var oldSuppressUIValue = true;

  try

  {

     oldSuppressUIValue = dte.SuppressUI;

     var strProjectPath = wizard.FindSymbol("PROJECT_PATH");

     var strProjectName = wizard.FindSymbol("PROJECT_NAME");

     var strSafeProjectName = CreateSafeName(strProjectName);

     wizard.AddSymbol("SAFE_PROJECT_NAME", strSafeProjectName);

     var bEmptyProject = 0; //wizard.FindSymbol("EMPTY_PROJECT");

    // Our custom code starts here -------------------------------------------------
    // 

    // This is method is called right before the wizard generates the project's files.
    // In this section we will generate a private key on-the-fly so that it can be used 
    // by the class-library. In .NET, private keys are generated by means of the SN.EXE
    // utility.  For example:

    //

    // SN.EXE -k mykey.snk  -- generates a private key and stores it in mykey.snk  

    //

    // Generating a private key from JScript is complicated by two factors:

    //

    //
1.) The SN.EXE utility must be called externally from JScript, which 
    //          requires the use of the Windows Scripting Host. 
    //      2.) The paths for both SN.EXE and the textfile that stores the keys 
    //          must be fully qualified.
    //
    //          Thus the command will really look something like:

    // 

    //    C:\Program Files\Microsoft Visual Studio .NET 2003\SDK\v1.1\bin\SN.exe -k 
    //         SomeDIR\MyTemplate\DBLayer\KeyName.snk

    // 

    // To fully qualifiy both paths we need to determine the directory where VS.NET is
    // installed, as well as the path for the project.  Thankfully, both pieces of 
    // information can be ascertained by means of the various objects are exposed to the 
    // wizard JScript from VS.NET.

    // Declare variables to store path information:

    var strAbsoluteProjectPath, strVSNETPath, strKeyName;

    var loc,loc1,loc2;

    // Retrieve the Solution name under which this project sits to give the key a name:                   

    strKeyName = selObj.Parent.FullName;

    // Parse the fullpath and add an ".snk" extension to give the key a name:

    loc1 = strKeyName.lastIndexOf("\\");

    loc2 = strKeyName.lastIndexOf(".etp");

    strKeyName = strKeyName.substring(loc1+1,loc2) +".snk"

    // Retrieve the path where the project is being installed:                

    strAbsoluteProjectPath = wizard.FindSymbol("TARGET").Parent.FullName;                

    // Add the path name to the keyname to fully qualify it

    loc = strAbsoluteProjectPath.lastIndexOf("\\");

    strAbsoluteProjectPath = strAbsoluteProjectPath.substring(0,loc+1) + strKeyName;         

    // Retrieve the path where VS.NET Installed:

    strVSNETPath = dte.Fullname;

    // Parse the VS.NET path to fully qualify the SN.EXE utility

    loc = strVSNETPath.lastIndexOf("2003");

    strVSNETPath  = strVSNETPath.substring(0,loc+4);

    strVSNETPath = strVSNETPath + "\\SDK\\v1.1\\bin\\sn.exe ";

    // Build the command we will execute through the Windows Scripting Host. The 
    // command will look something like:        
    //
    //    C:\Program Files\Microsoft Visual Studio .NET 2003\SDK\v1.1\bin\SN.exe -k 
    //         SomeDIR\MyTemplate\DBLayer\KeyName.snk         

                     

    strMakeKeyCommand = "\""+strVSNETPath+"\" -k \"" + strAbsoluteProjectPath + "\"";

    // Execute the command using the Windows Scripting Host, thus building the 
    // private key:                      

    oShell = new ActiveXObject("WSCript.Shell");                        

    oShell.Run(strMakeKeyCommand);

   // Store the keyname in a "Wizard" variable so we can reference it in the 
   // AssemblyInfo file. Referencing keyfiles is somewhat odd in C#, so we must build a 
   // string that specifies the keyfile path relative to the class-library 

   // (..\..\..\MyKey.snk):
        wizard.AddSymbol("KEYPATH_FOR_ASSEMBLY","\"..\\\\..\\\\..\\\\"+strKeyName+"\"");

   // The key has been built, and so let the boilerplate code take over.  The only
   // remaining step is to modify the assemblyinfo.cs file to reference the key, which 
   // you did in the previous step in the lab.
   //  Our custom code ends here -------------------------------------------------------



  var proj = CreateCSharpProject(strProjectName, strProjectPath, "..\\projects\\csharp building blocks\\" + wizard.FindSymbol("EFT_PROTOTYPE") );

  var InfFile = CreateInfFile();

  if (!bEmptyProject)

  {

     AddReferencesForClass(proj);

     AddFilesToCSharpProject(proj, strProjectName, strProjectPath, InfFile, false);

  }

     proj.Save();

     CollapseProjectNode( proj );

  }

  catch(e)

  {

      if( e.description.length > 0 )

   
   SetErrorInfo(e);

      return e.number;

  }

  finally

  {

      dte.SuppressUI = oldSuppressUIValue;

      if( InfFile )


  InfFile.Delete();

  }

}


Table 2.4 – JScript code to generate a private key 
· After pasting the new code into default1.js, save the file and close any instances of NOTEPAD.

Task 4 – Testing the template
· Open Visual Studio .NET 

· On the File menu, point to New, and then click Project.
· The New Project dialog box appears.
· In the Project Types pane, expand the Other Projects folder and select the Enterprise Template Projects folder. The Templates pane displays a number of icons, including your template MyTemplate (see Figure 1.8).

· Accept the default project name and location, and click OK. If you made any errors during the wizard construction process, Visual Studio .NET will display them at this point.
· While Visual Studio .NET is creating the project you may see the quick display of a Command Prompt window; this is the wizard code executing the SN.EXE utility to generate the private key.

· As before, Visual Studio .NET will create an entire three-tier solution for you based on the template’s architecture.  

· Examine the AssemblyInfo.cs file within the DBLayerproj project, and you will discover that it has been associated with the private key that was generated on-the-fly:

[assembly: AssemblyKeyFile("..\\..\\..\\DBLayer.snk")]
· To test that the key was correctly referenced in the AssemblyInfo file, build the project by going to the Build menu and clicking Build Solution.

· Close Visual Studio .NET.
It is important to note that every project instance created with this template gets its own unique private key.  Such behavior is in stark contrast to the static prototype approach, where the contents of project instances did not change.

Task 5 – Customizing the New Project Dialog Box

In practice, Enterprise Templates are often coupled with the customization of the Visual Studio .NET environment.  This final aspect of the lab is an example of the latter. Refer back to Figure 1.8 and you will see that your template icon appears in the Other Projects\Enterprise Template Projects folder of the New Project Dialog Box.  In a real-world scenario it may be preferable to have the icon appear in its own folder as opposed to this obscure location.  The following steps create a custom folder in the New Project Dialog Box by means of some file manipulation and registry settings.

Recall that in part 1 of the Lab (Task 2) you created a file named MyUserTemplate.vsdir within the following directory:

C:\Program Files\Microsoft Visual Studio .NET 2003\EnterpriseFrameworks\ProxyProjects

· It is this .vsdir file that embeds the template icon into the New Project Dialog Box.  To give your template its own folder, navigate to the aforementioned directory with the Windows Explorer. 

· Right click the right pane of the Explorer (where the files are listed), point to New and select Folder.
· A folder named New Folder is created for you.

· Rename the folder MyTemplateFolder
· Copy the MyUserTemplate.vsdir file from the following directory: 
..\%VSNETRoot%\EnterpriseFrameworks\ProxyProjects
to the following directory:

..\%VSNETRoot%\EnterpriseFrameworks\ProxyProjects\MyTemplateFolder directory

· Delete the MyUserTemplate.vsdir file from the ..\%VSNETRoot%\EnterpriseFrameworks\ProxyProjects directory

· The MyUserTemplate.vsdir file must be modified to reflect its new location.  Using NOTEPAD, open it from its new directory (…\EnterpriseFrameworks\ProxyProjects\MyTemplateFolder), and add “..\” to the beginning of the first line.  In other words, the first line should now look like:
..\..\Projects\MyTemplate\MyTemplate.etp|{AE77B8D...

instead of:

..\Projects\MyTemplate\MyTemplate.etp|{AE77B8D...

Before you can add the appropriate entries to the registry to enlist your new folder with Visual Studio .NET, you must first generate a Globally Unique Identifier (GUID).  A GUID is a 128-bit unique number that is often used by Windows Applications to identify unique entities such as components, files and resources.  To generate a GUID on the system:
· Point to the Start menu, then Programs, then Microsoft Visual Studio .NET 2003, then Visual Studio .NET Tools then Visual Studio .NET 2003 Command Prompt (see Figure 2.2)
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Figure 2.2 – The VS.NET 2003 Command Prompt

· The Command Prompt window appears
· Type “guidgen” at the prompt and press Enter.  This will launch the GUIDGEN utility, which will generate custom GUIDs for you.

· Click the New GUID button and then click the 4th radio button to store the GUID in a format appropriate for the registry (see Figure 2.3)
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Figure 2.3 – The GUIDGEN utility

· Click the Copy button in the GUIDGEN utility.

· Close the GUIDGEN utility.

You have now generated a GUID that can be used to represent your custom folder to VS.NET.  The last remaining step is to make the appropriate registry entries.

· Point to the Start menu and then click on Run.

· Type “regedit” at the Run Dialog Box, which will launch the Windows Registry Editor
· Navigate to the following registry folder, which maintains a list of those folders that VS.NET lists in the New Project Dialog Box:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\VisualStudio\7.1\NewProjectTemplates\TemplateDirs

· Right click the TemplateDirs folder, point to New and click Key
· A key named New Key is added to the folder.

· Press CTRL-V and press ENTER to rename the key to the GUID value you copied in the GUIDGEN utility.

· Right click the folder you just renamed, point to New and click Key.

· A key named New Key is added to the folder.

· Rename the key “/1” 

· Right click the “/1” folder you just created, point to New and click DWORD value.

· A key named New Value #1 is added to the right pane of the editor.

· Rename the key SortPriority.

· Once again, right click the “/1” folder, point to New and click String value.

· A key named New Value #1 is added to the right pane of the editor.

· Rename the key TemplatesDir
· Double click the TemplatesDir key in the right pane of the editor.
· The Edit String Dialog Box appears, which allows you to give the key a value.
· Give the key the following value (where C:\ is the drive where VS.NET is installed)

C:\Program Files\Microsoft Visual Studio .NET 2003\EnterpriseFrameworks\ProxyProjects\MyTemplateFolder 
· On the right pane of the editor there is a final key named Default – double click it.

· The Edit String Dialog Box appears; give the key a value of MyTemplateFolder
A sample of the final registry settings you should have are depicted in Figure 2.4 (note that your GUID key name will differ).
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Figure 2.4 – Final registry settings
Note: you did not have to give the SortPriority key a value since it defaults to 0 when you create it. This value results in the folder being displayed first in the New Project Dialog Box.

To test your changes:
· Close Visual Studio .NET 2003 if it is open.

· Open Visual Studio .NET 2003.

· On the File menu, point to New, and then click Project.
· The New Project dialog box appears.

· As illustrated in Figure 2.5 your new folder (MyTemplateFolder) appears in the left pane of the Dialog Box, whereas the available project types (MyTemplate) appear in the right pane.  
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Figure 2.5 – The modified New Project Dialog Box

Addendum – Visual Studio Enterprise Templates Policy Editor: 

<Instructor Notes: The setup for the Enterprise Templates Policy Editor is included in the lab setup directory.>
This section of the lab is only to be completed if you have extra time left.  In the first excecise in the lab you implemented rules for the template by editing the raw XML policy file. This manual approach was illustrated to give you a ‘nuts and bolts’ understanding of Enterprise Templates.  

With the introduction of Visual Studio .NET 2003 Microsoft has released a Visual Studio Enterprise Templates Policy Editor that frees you from the burden of modifying the raw XML file.  The following exercise will give you an introduction to the Enterprise Templates Policy Editor to help you understand how it can simplify the development of policies with Enterprise Templates.

Task 1 – Verify Policy File

· Open Visual Studio .NET 2003 if it is not already open (close any solutions if it is already open)

· On the File menu, point to Open, and then click Policy File
· The Open File dialog box appears

· Browse to the policy file you associated with the template in the previous lab.  The policy file can be found in the following location (where C:\ is the drive where the VS.NET is installed):
C:\Program Files\Microsoft Visual Studio .NET 2003\EnterpriseFrameworks\Policy\MyPolicy.TDL

· Click Open to load the policy file into Visual Studio .NET 2003
· In the Policy Editor, on the Select Element Type Tree View, expand the Project node
· Select the projUILayer node

· Select <All> from the Elements In Category combo box
· Check the Allow Unknown Elements checkbox
· In the Allowed Elements list view, scroll down to the codeWinForm
· Observe the Allowed value of codeWinForm is set to the value which corresponds to the steps taken in Exercise 1, Task 4
· Now verify the other policies set in the lab
· Close and reopen the solution
Task 2 – The Policy Editor

In this task we will use the policy editor to constrain the menu items available to a developer.

· Start Visual Studio .NET 2003
· Select the File | Open | Policy File…
· From the Open dialog, select the DAP.tdl file

· Select the File | Save DAP.TDL As…
· In the Save As dialog, specify TechEdPolicy

· In the Policy Editor, select the Features tab.

· In the Features with Constraints tree view, right click on the Menu node and select Add Menu…
· The Add Menu Constraint dialog appears

· Select the menuProject.AddModule item from the Available Menus list

· Click Select
· Click OK

· In the Features with Constraints tree view select the menuProject.AddModule child element in the tree view

· In the Constraints for Selected Feature tree view, right-click on the Elements node and select Add Element
· Select projItemVBCodeFile, projItemVBModule, projVBProject, and projSystem from the Available Elements list

· Click the Select 

· Click OK
· Select the File | Save TechEdPolicy.tdl 

· Create a new Visual Basic .NET Windows Application, use the name TechEdWindowsApplication.

· In the Solution Explorer, select the TechEdWindowsApplication project icon
· In the Properties window, select the Policy File and browse to the TechPolicy.tdl file

· Click Yes on the prompt to reload the project

· Select and right-click the TechEdWindowsApplication project icon

· Select Add
· Notice you can no longer add a Module to the project
Lab Summary

In this lab you created an Enterprise Template to promote the division of an application into three logical tiers.  You initial template was based on static prototypes, whereby all project instances created with the template contained the same files.  Creating Enterprise Templates based on static prototypes was primarily a matter of intricate file manipulation.  In the final part of the lab you implemented certain rules for your template by means of the policy file and Template Description Language (TDL). 
In the second part of the lab you added some dynamic content to the template by means of wizards.  Wizards allow developers to execute operations on-the-fly during the creation of a project instance.  In this lab you wrote some JScript code to generate a private key using the SN.EXE utility and associate it with the ClassLibrary source in the Database-tier of the newly created project.  Finally, you gave your template its own folder in the Add New Project Dialog Box in Visual Studio .NET by means of wizards. 
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